
Въведение в DERIVE 
 
Компютърната алгебрична система DERIVE (CAS DERIVE) често се описва като 
“математически асистент”. Тя е мощен и лесен за използване компютърен пакет за решаване на 
разнообразни математически проблеми. Целта на настоящото пособие е да представи някои от 
основните функции и команди на DERIVE. 
 
1. Екранът на DERIVE. 
 
Когато стартирате DERIVE ще се появи екран, който изглежда по следния начин: 
 

кранът на DERIVE е сходен с този на основните програми под WINDOWS.  

ова, което виждате е тъй наречения алгебричен прозорец. Той се използва за писане и работа с 

ERIVE разполага и с 2D и 3D графични прозорци. 

 следващите няколко параграфа ще се научите  как да въвеждате и да работите с алгебрични 

 
Е
 
Т
алгебрични изрази, уравнения и формули. В долната част на екрана има тясно дълго поле, в 
което се извършва въвеждането. Ще го наричаме поле за въвеждане. Под него има две групи с 
бутони. Лявата група се състои от големите и малки гръцки букви, а дясната от основните 
математически символи. 
 
D
 
В
изрази, уравнения и да чертаете графики.  
 



2. Въвеждане на изрази в DERIVE. 

лед стартирането на DERIVE обикновено маркера е в полето за въвеждане. Ако маркера не е 

. Въведете израза 

 
С
там, то кликнете в него с левия бутон на мишката. Вече сте готови да въвеждате на изрази или 
уравнения в DERIVE. 
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+− . I За целта в полето за въвеждане напишете 1/4 Β 6/12 + 9/17. 

 Enter от

абележка 1:  
огато въвеждате изрази в DERIVE всички стандартни клавиши за редактиране от клавиатурата 

жение: ←, →, Home, End, Backspace(←) и Delete. 

иснете Enter. 
а екрана ще се появи: 

 
израза

Натиснете клавиша  клавиатурата..  
На екрана ще се появи следното 
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са ви на разполо
 
II. Въведете израза 927: В полето за въвеждане напишете 9^27. Нат
Н
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xIII. Въведете : Напишете (x – 4)/(x^2 – 9x +20). Натиснете Enter. 

и: 
 
На екрана ще се появ

 
IV. Сега въведете израза 
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 сами. 

. Внимавайте, къде и как поставяте скобите. При въвеждане на изрази и уравнения можете да 
 следните скоби ( ). Не използвайте квадратни скоби [ ]. Те са запазени за 

2. 

елта направете следното: 

- 
 
 

. Въведете сами израза

 
Забележка 2:  
1

използвате само
въвеждане на вектори и матрици. 
След натискането на Enter проверете дали изразът, появил се на екрана изглежда като този, 
който е трябвало да въведете. 

3.  Ако изразът появил се на екрана не отговаря на израза, който е трябвало да въведете, то 
трябва да го редактирате. За ц
- Кликнете два пъти върху номера на реда, в който е израза. Като резултат в полето за 

въвеждане ще се появи копие на този израз.  
- Извършете необходимите поправки и натиснете Enter.  

Върнете се към точка 2. 
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V .  



 
Забележка 3:  
За да въведете ,  изберете един от следните два варианта: 

дете sqrt и след това в скоби напишете израза под корена т.е. 
(d

Вариант I: Въве
 Въведете  sqrt ^2 – f^2)/(d – f) ↵. 

Вариант II: В полето с математически символи кликнете върху бутона  и знакът за корен ще 
ед това в скоби напишете израза под корена т.е. се появи в полето за въвеждане. Сл

 Въведете  (d^2 – f^2)/(d – f) ↵. 
 
VI. Като работите по схемата, дадена в точка 3 на забележка 2, редактирайте така израза, че да 

олучитеп  
fd −

 
3. 

fd − . 

ване н  в DERIVE
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Опростя а изрази . 

тим всеки от  въведените дотук изрази. 
 
Сега ще използваме DERIVE за да опрос
 
I. Опростете 
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+− , като кликнете с левия бутон на 

ишката върху номерa на реда, в който се намира. Изберете от менюто Simplify. След това 
.  

м
изберете Basic
Ще получите следния резултат: 

51
10 .  

 
Забележка 4:  
1. Фабричната настройка на DERIVE е такава, че връща резултата като дроб. 

атък, когато искаме да укажем, че трябва да извършите няколко операции 2. От тук нат
последователно, както по-горе при опростяването на 

1712

следния начин: Маркирайте израза 

97
4
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+− , ще записваме това по 
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+−  >  Simplify

ишете резултата като десетично чи кирайте реда, в кой

 > Basic. 

 
Зап сло: Мар то се намира дробта > 
атиснете бутона Ζ. Н

 

Сега ще демонстрираме  .  друг, по-бърз начин за опростяване изрази, чрез бутона
 

II. Маркирайте израза 927 > Натиснете бутона .  
Ще получите следния резултат: 
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III. Опростете сами изразите 
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 , като маркирате всеки от тях и 

използвате бутона . Трябва о: 

 

 да получите съответн
  

 



 
 и за всеки от тях 

атискате клавиша Delete. 

. Разлагане на множители

Изтрийте всички въведени дотук изрази, като ги маркирате един по един
н
 
 
3 . 

раза Въведете израза > Натиснете Simplify > 
actor > Factor. 

 
I. Разложете на множители из  1827172 23 ++− xxx : 
F
Ще получите следния резултат:  

 
4. Разтваряне на скобите. 
 
I. Разтворете скобите в израза (3x – 5)(2x – 1)(4x – 3):  Въведете израза  > Натиснете Simplify > 

xpand > Expand. Ще получите: 

равнен  в DERIVE

E
 

II. Разтворете скобите в израза ( )105+x . 
 
 
5. Въвеждане и решаване на у ия . 

. Решете уравнението Въведете израза x^2 + 5x + 6 > натиснете Solve > 

изписвате “= 0” накрая т.е 
остатъчно е да въведете израза f(x) и да натиснете Solve > Expression > Solve. 

: 
- Маркирайте реда, в който се намира израза ++− xxx   

веждане не е пр
него с дес го с  

- 
- го по указания в точка I начин. 

 

 
I 0652 =++ xx : 
Expression > Solve. Ще получите следния резултат: 

 
Забележка 5: 
За да решите кое да е уравнение от вида f(x) = 0, не е необходимо да 
д
 
II. Решете уравнението 1827172 23 ++− xxx  = 0. Тъй като от точка 4 имате вече въведен израза 

1827172 23 ++− xxx , то не е необходимо да го пишете наново. Извършете следните операции
23 1827172

- Ако полето за въ азно, то го изпразнете по следния начин: Кликнете в 
ния бутон на мишката и маркирате изразa, намиращ се там > Изтрийте 

Delete. 
- Натиснете F3 и желания израз 1827172 23 ++− xxx  ще се появи в полето за въвеждане.  

Натиснете Enter. Вече сме готови да решим уравнението.  
Решете 

 



6. П ер работка на формули. 
 

 Въведете формулата 
au

up
−

=
16I. . Тук променливата p е изразена чрез променливите u и a. Ако 

ата а чрез u и p, то е необходимо да направим следното: Въведете 
зраза 
искаме да изразим променлив
и

au −
променливата а > Solve. 
Ще получите следния резултат: 

up =
16  > Натиснете  Solve > Expression > В Solution Variables маркирайте 

чрез a и p. 

.  Заместване

 
II. Сега преработете дадената формула, така че u да бъде изразено 
 
 
7 . 

ъведете формулата Заместете променливите отдясно със следните техни стойности 

. За целта: Въведете формулата > натиснете бутона

 
 ( )na θ1ρ += . 

5=

В

 ,3/1=θ,10=ρ n  . 
 излезлия прозорец, направете следното:  

- маркирайте променливата 〈 > кликнете в полето New Value: и напишете 10; 
- маркирайте иш е 1/3.  

Сега запишете резултата като десетично число. 

В
- маркирайте променливата n > кликнете в полето New Value: и напишете 5; 

променливата ¬ > кликнете в полето New Value: и нап ет
Ще получите следния резултат: 

 
 
Изтрийте всичко въведено до тук.  
 
 
8. Чертаене на графики. 
 

I. Начертайте графиката на функцията y x= −3 2 : Въведете 3x – 2 > Натиснете бутона  .  

е операции ще се появи нов – графичен прозорец, който ще покрие 
който работихме до сега. В графичния прозорец има начертана 

 система. 

 
В резултат на извършенит
лгебричния прозорец, с а
координатна
 

Натиснете отново бутона   и графиката на y x= −3 2  ще бъде начертана върху дадената 
координатна система, както е показано по-долу. 
 



 
II. Начертайте графиката на функцията y x= +5  върху същата координатна система.  
Трябва да получите следното: 

 
Забележка 6: 
1. За да се върнете в алгебричния прозорец, използвайте бутона  . 
2. Ако искате да  виждате едновременно и алгебричния и графичния прозорец, направете 

следното: От менюто изберете Window > Tile vertically.  
3. За да преминавате от единия към другия прозорец достатъчно е само да кликвате върху 

прозореца, в който желаете да работите в дадения момент. 
 
III. Намерете координатите на пресечните точки на двете графики. 
 
Най-напред направете това графично:  

1. В графичния прозорец използвайте бутоните   за да видите 
пресечната точка на двете линии.  

2. Кликнете върху бутона . Върху едната от двете графики ще появи малко кръгче. С 
клавишите ↓ и ↑ от клавиатурата може да прехвърляте това кръгче от едната графика на 
другата. А с клавишите  ←, → може да предвижвате кръгчето по графиката, върху която се 
намира. 

3. Придвижете кръгчето до пресечната точка на двете прави. В левия ъгъл под графиката ще 
видите изписани координатите на тази точка: Cross: 3.541667, 8.541667 



 
 
Сега намерете координатите на пресечната точка аналитично, като решите системата от 
уравненията на двете прави: 
1. Преминете в алгебричния прозорец. 
2. От менюто изберете Solve > System.  
3. В излезлия малък прозорец е необходимо да посочите броя на уравненията в системата, 

която ще решавате: В полето Number: напишете 2 > Ok. 
4. Ще се появи нов прозорец, в който трябва да посочите двете уравнения. Тъй като вече имате 

въведени тези уравнения не е необходимо да ги пишете наново. Достатъчно е да въведете 
само номерата на редовете, в които се намират, а именно #1 и #2, както е показано по-
долу.  Натиснете Solve. 

 



5. Ще получите следния резултат : 

 
 Запишете отговора чрез десетични числа.  
 
II. Начертайте параболата  и правата y x= 2 y x= +2 24 . Намерете координатите на пресечните 
им точки, първо графично, а после аналитично. 
 
Затворете графичния прозорец. Изпразнете алгебричния, като маркирате всички изрази и 
натиснете Delete. Разположете го върху целия екран, като кликнете два пъти върху синята лента 
в горния му край. 
 
 
9. Диференциране. 
 
I. Намерете производната на функцията ( ) 23 23 ++= xxxf : Въведете  > 

Натиснете 

23 23 ++ xx

 > Variable: x > Order: 1 > Simplify. 
Ще получите следното: 
 

I. Намерете производната на функцията

0. Интегриране

 
I  ( ) xxxf sin= 3 . 
 
 
1 . 

. Пресметнете неопределен интеграл от функцията Кликнете върху номера на 

иснете 

 
I  ( ) xxxf 6+3= 2 : 

реда, в който се намира израза xx 6+3 2 > Нат  >
plify. 

овторете процедурата, като този път напишете c в полето Constant: на прозореца, излизащ 

 Variable: x > Изберете 
неопределен интеграл Indefinite > Sim
Ще получите следното: 

 
П

след натискането на . 
Ще получите следното: 
 



 
II. Пресметнете неопределен интеграл от функцията . ( ) xxxf sin= 3

 
 
11. Въвеждане на текст в прозореца на DERIVE. 
 
За да въведете текст в DERIVE, направете следното: 
1. Ако алгебричният прозорец е празен, то изберете от менюто Insert > Text object > 

Кликнете в появилия се правоъгълник и въведете желания текст. 
2. Ако алгебричният прозорец не е празен, то маркирайте реда, след който искате да въведете 

текста и повторете процедурата в точка 1. 
3. Ако желаете да пишете на български, то още преди да сте кликнали върху Insert, изберете 

от менюто Options > Display > Font of New Text Objects > Изберете желания шрифт 
(Font) > Преминете към кирилица > Изпълнете съответно точка 1 или точка 2, в 
зависимост от ситуацията, която имате. 

 
 
12. Някои полезни клавиши: 
 
Клавиш Употреба 
F3 Копира маркиран израз от алгебричния прозорец в полето за въвеждане. 
F4 Както F3, но изразът в полето за въвеждане ще бъде поставен в скоби. 
F1 Бързи клавиши за използване на Help менюто. 
Ctrl E Бързи клавиши за въвеждане на Неперовото число е. 
Ctrl P Бързи клавиши за въвеждане на числото ◊. 
Ctrl Q Бързи клавиши за въвеждане на квадратен корен. 
Ctrl I Бързи клавиши за въвеждане на имагинерната единица i. 
 
 
Забележка 7:  
1. Числата е, ◊ и i могат да бъдат намерени и под алгебричния прозорец в групата бутони с 

математически символи. 
2. В DERIVE числата е и i се изписват съответно по следния начин ⎢ и ⎩. 
 
 
 
14. Някои полезни вградени функции на DERIVE.  
 
Експоненциална функция: 
EXP(z) – експонента от израза z, т.е.  (Когато въвеждате , вместо EXP(z), може да въведете  
израза ⎢^z). 

ze ze

 
Логаритмични функции: 
LN(z) – Натурален логаритъм от израза z(z > 0). 
LOG(z) – Натурален логаритъм от израза z(z > 0). 
LOG(z, 10) – Десетичен логаритъм от израза z(z > 0). 
LOG(z, a) – Логаритъм от израза z(z > 0) при основа a. 



 
Тригонометрични функции: 
SIN(z) – sin z 
COS(z) – cos z 
TAN(z) – tg z 
COT(z) – cotg z 
 
Обратни тригонометрични функции: 
ASIN(z) – arcsin z 
ACOS(z) – arccos z 
ATAN(z) – arctg z 
ACOT(z) – arccotg z 
 
Забележка 8: 
Не е задължително имената на функциите да бъдат изписани с големи букви. 
 

 
Автор: гл.ас. Ева Димитрова 
 


	 

